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Introduction

To run AlphaCAM effectively the user (that’s you) needs to understand the
basics of the Windows ™ operating system and be capable of the following
tasks related to the computer system.

There are several versions of windows currently being used and more to come.
It is intended to keep this tutorial as neutral as possible, but Windows by its
very nature is user configurable, and in some cases the pictures shown may not
match your screen display exactly, though the description should make this of
no consequence.

Starting and Stopping the Computer.

Understand the following terms: -

Hardware, Software, Programs,

Data, Text, Graphics,

Files, Drives, Directories / Folders,
Disk Structure, Backup,

Log On, Log off,

Desktop, Icons, Shortcuts,

Taskbar, Task Switching,

Drag & Drop, Click, Double Click
Menus Types - Popup, Pull Down and Cascade
Toolbars,

Screen Saver,

Understand the use of these buttons D @ IXI

and these symbols &~/ | [ M ©
Editor

Be able to control the mouse and its buttons.
Be able to create text data, save it and retrieve it for editing.

Manipulate text data using the “Move” “Copy” “Find” and “Replace” functions.
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Glossary of terms

Understanding the terminology used in conjunction with computers is
important to mastering the system.
Hardware

These are the physical items of equipment, which make up the

% system. They are similar to the machine, controller, vices, tools
E & fixtures etc., which are the Hardware Items that make up a
= — machine tool

Software
These are the programs sitting inside a computer, which make
things happen. They are similar to programs and the controller
operating system that makes the CNC machine work.

Programs

These are lists of instructions written in a language that the
computer understands which perform a series of tasks, just as the
NC program is a series of instructions that cause the machine tool
to perform an action.

This is a general term for information or content, irrespective of
format or type.

Text
folat - This is data in the form of words, letters and numbers, as in a

\— letter, note, or memo. [=] >4

This is data in the form of lines, arcs, and pictures, as in a
drawing, sketch or photograph. @ﬁ

These are general items in which data is stored, as in a sheet of

paper or book
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Directories / Folders
- These are items in which a group of files can be stored, as in

filing cabinet drawers, sections, and folders. 7 ]
Directories or Folders are the same thing.

Drives

These are designated areas in which Files and Folders are stored.
Each drive is allocated a recognition letter as A,B,C,D ... Z. A

drive is the computer’s equivalent of a filing cabinet.
Disk Structure

This is the organisation of the Drives, Folders, and Files. Each

—— item of data stored on the computer system has a unique position
B within the disk structure. The disk structure is sometimes
‘\ displayed like a family tree, the route through the tree is called

1 the path. The disk structure is the same as a normal filing system;

ie each piece of information has a set location within the
— Organisation.
E.G The drawings are stored in the drawing filing cabinet. The
drawers are labelled A-C ,D-F ... Each drawer has sections marked
A B C ... In each section there are folders labelled with the
customers name. In the folders are the drawings related to that
customer

\

This is the process where the accumulated data stored on the
computer system is copied on to another data storage device such
as, Floppy disks, Optical disks, or Magnetic Tape, which can be
stored in a safe place. This is a security procedure to protect the
data you have created on the computer system.

REMEMBER

Hardware and Software can be re-purchased.
The work you do CANNOT.

www.licom.com Page 6
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Logging On

This is the procedure by which you identify yourself to the
_computer/network system. Logging On may also involve entering
— " =4 a password. A password is a security item which endeavours to
~ ensure only you can log in.
Logging On is part of the start up procedure.

REMEMBER:

if you do not “Log On”
you may not be allowed access to parts of the system.

Desktop
R The desktop refers to the computer screen on which everything is
siss displayed. Items called shortcuts can be placed on the desktop to
allow fast access to programs or files. The desktop may display a

background picture.

Icons
These are picture representations of an item, which allow simple
by Computer .
¥ access to the data. For example the small pictures shown on the
Recyde Bin desktop above are icons.
Shortcuts
By These are objects, which allow quick access to files or folders.
‘windoms . . .
E%] The icons shown on the previous desktop picture are shortcuts.

Drag and Drop

This is a procedure whereby data, text or an item is picked up,
dragged, then dropped in a new position, into a program, or onto
an icon.

The drag and drop is performed by positioning the mouse cursor
over the object to be dragged, holding down the left mouse
button, dragging the object to its required position and dropped
by releasing the left mouse button.

Mave Hore If the Drag and Drop is performed with the right mouse button a

Create Shortcut(s) Here

= popup menu is displayed when the button is released.
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Click, Double Click

Window

Minimise

Taskbar

4] End
& Hep
i1 Run..

& Shut Down,

Ii Shart

To Click on an item position the mouse cursor over the required
item then press and release the mouse button in a swift action,
being careful not to move the mouse as this is a drag and drop
action.

: Left Click refers to pressing and releasing the left-hand mouse

button.

: Right Click refers to pressing and releasing the right-hand mouse

button.

: Double Click refers to pressing and releasing the mouse button

(usually the left) twice in quick succession. This may be activated
by a single click on the middle button when a 3-button mouse is
used.

This is an area of the screen in which programs work. A window
can cover the whole of the VDU display (A Full Screen Display),
or a portion of the display area (Windowed View). The display

can be swapped from a window to a full screen by a left double

click with the cursor in the title bar of the application.@

This is when the display area of a program (a window) is shrunk
into a small button on the task bar. The program will still be
working and the window can be re-displayed by a left click on

the minimised button in the taskbar.g

This is a part of the screen in which the names of all the active
programs are displayed. The taskbar is normally stored at the
bottom of the screen but can be on any one of the 4 edges. The
taskbar can be set to be permanently visible, or only appear when
the mouse cursor is moved into it.
s | The taskbar contains the Start menu from which all
objects can be accessed.
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Task Swapping

Task swapping is the means by which active programs are made
current. With Windows, several programs can be running at the
same time, but the program being worked on is said to be the
current program. There are several ways in which to set the
current program.

In the taskbar pick the program which is required.

Hold down the keyboard key marked and press the TAB key
marked a dialog box will be displayed showing the active
programs icon.

Each press of the key will move the indicator to the next
item. The program indicated when the key is released will be
made current.

If the required programs’ screen is visible on the desktop it can be
made active by positioning the cursor in the program screen and
clicking the left-hand mouse button.

Menus
These are lists of available commands associated with an
application program. Windows displays the actionable commands
in bold. Any commands that are not currently valid are displayed
using faint characters (the options are greyed out). There are three
types of menu:

Help A Pull Down menu is displayed below the
AlphaCAM Help 1 selected menu header. Usually activated by the
AlphaCAM OnLine - Information left mouse button.

Licom Web Site 3

About Advanced Mill._.
Licom ¥ideo Help

A Pop Up menu is displayed at the cursor position zeom an

Usually activated by the right mouse button. Zoom Window
Zoom Previous
Zoom Out
Redraw

A Cascading menu is displayed
About Advanced Mill. i::)'::l‘ﬁ:";‘:;_sine at the side of a menu item
I iram Vidan Heln |nd|cated by >.
Some cascading menus require the cursor to be dragged over the
» before they are displayed.

www.licom.com Page 9
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Toolbars

Toolbars are panels of icons, which provided quick access to
Dl(e| & ¢=l@| =slcommands. Windows applications provide toolbars for the
frequently used commands such as:

“Save” |E| “Open” |E| “Print” %l
“Cut” il “Copy” “Paste” |E|

Fast Keys are letter keys pressed in combination with the control
key that active commands similar to Toolbars.

“Save” + (S) “Open” + (O} “Print” + (P)
“Cut” + (X) “Copy” + (C) “Paste” +

Fast Keys

Screen Saver

The screen saver is designed to save the screen from damage,
which can be caused by constantly displaying the same image.
Screen savers can be moving images or cause the screen to be
turned off. When a screen saver is active, moving the mouse or
pressing any key, preferably the Space Bar, will return the screen
to its normal display.

Editors

Eliiswaed =92 An editor is a program whose function is to create and/or edit

in notepan o snow - teXt files. A word processor is an editor with extra functionality

i 1235 o for formatting and manipulating text. There are two editors
provided with Windows, a basic editor called Notepad and a

more advanced editor called Wordpad.

1 AlphaCAM provides a multi-window editor called AlphaEdit, this
is a text editor with additional functionality for manipulating NC
programs and for communicating to machine tools.

www.licom.com Page 10
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Button Icons

Throughout all windows applications there are common symbols,
some of which are explained below:
5 Restore In the top left corner of an application window is the application
icon. When the cursor is positioned over it and left mouse button
clicked, the window control pull down menu will be displayed.
xoee Ak | |n the top right corner of an application are 3 shortcut buttons to
control the window.

— Minimize

|:| This icon button minimises the screen into a taskbar
button.

@ These icon buttons swap between a full screen and
a windowed display.

This icon button will Close the application.

Cursor Shape

The shape of the mouse cursor is used to indicate the current
function.

R The arrow cursor is for picking objects.

< The double-headed arrow indicates the resizing function.
oY It appears when the cursor is on the sides or top and

3 bottom edges of a window.

|

The vertical bar cursor indicates the position at which text
will be displayed when it is typed in.

| The beam cursor is the positioning cursor when text entry
is required.

Switches

A switch indicates whether an item is active. There are two types
of switch, a radio button and a check box.

® On Radio button switches will only allow one item in a
O Off group to be selected.

M On Check box switches allow any or all options in a

O Off group to be selected

www.licom.com Page 11
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Starting up and Shutting down the Computer
Starting up

To start up the computer is very simple. Press the “power on button”.

If the VDU does not start up, press the “power on button” on the VDU.

The computer may start up and display the Desktop or it may display a Login
dialog box.

Enter Network Password d |

Emter your network. password for Microzaft Metworking.,
m
e == Cancel |

zer name: ITraining

Pazzword: I

The login screen will display the last login name “Training” and the vertical
cursor will be flashing in the Password section of the dialog box.

Licom does not use a password for training users. If your system requires a
password, Type the password on the keyboard. Type carefully as an * will be
displayed in place of each letter. This is so no one can see your password.

If you press a wrong letter, pressing the Back Space key, marked on the
top right of the keyboard, will remove the incorrect letter and the correct letter
can then be re-typed.

When you have typed in the password, position the mouse over the
button on the dialog box and click the left mouse button (7.

If you enter an incorrect password
a re-enter password dialog will be displayed.

When you have logged in correctly the Desktop will be displayed. The Desktop
display will be the same as when the system was last shutdown.

www.licom.com Page 12
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Shutting down

Before the power to the computer is switched off, the operating system needs to
be shut down. The procedure of shutting down ensures that all settings are
saved and any open files or active programs are closed in a correct manner.

You must NOT simply switch off the power — this will cause problems.

To shut the computer down, pull the arrow cursor to the bottom of the screen
where the hidden taskbar is usually stored.

On some systems the taskbar is visible all the time and it may be placed on
either the top, bottom, left or right, side of the screen

35‘"2 *| Position the cursor over the Start button and click {J the left mouse
1 button. This will cause the Start Menu to be displayed.
8 Skt Down. Position the cursor over the Shut Down menu

[ stan w126 | command and click (J the left mouse button.

The Start Menu and the taskbar will disappear and the shutdown dialog box
will be displayed.

Shut Down Windows X|

@ Are you sure pou want ko

% Shut down the computer®

™ Restart the computer?
™ Restart the computer in M5-D05 mode?

{™ Cloze all programs and log on as a different uzer?

Yes No | Help

The “Shut down the computer” radio button should be active, if it isn’t,
position the cursor on the button and click J the left mouse button.

To shut the computer down, pick the button.

The desktop display will be replaced with the shutdown display.
When the display shows

It’s now safe to turn off your computer

Press the power off button and the computer will be properly switched off.
Some computors automatically switch off on shutdown.

[E Try starting and stopping the computer several times.

www.licom.com Page 13
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Accessing Applications
Opening Application Folders

Application folders are where similar application icons are grouped together,
eg. the application icons for Calculator, Notepad and Paint are grouped
together in the Accessories folder.

To open the Accessories folder position the cursor over the Start button on the
taskbar and right click. A popup menu will be displayed. Pick the Open
command.

The Start Menu folder will be displayed on the desktop. Position the cursor on
the Programs icon and 2{J Left Double click.

The Programs folder will then be displayed on the desktop. Position the cursor
on the Accessories icon and [ Left Double click.

The Accessories folder will then be displayed on the desktop.

[B" Try opening applications in the Accessories folder.

Starting Applications

There are several ways in which to start an application, the most common
being:-

Double Click the left mouse button with the cursor on the application shortcut.
Or

Right Click with the cursor on the application shortcut. A popup menu will be
displayed. Pick the Open command with a single click {J of the left mouse
button

Or

Select the application command from the menus which cascade from the
Programs command on the Start Menu

Stopping Applications

To Close an application either select the Close command from the “File”
pull down menu or {J left click with the cursor on the application close button
at the top right of the window.

[E" Try starting and stopping the following applications,

Calculator,

Notepad
Paint.

All of these applications can be found on the Accessories Menu. This menu can
be located through Programs on the Start Menu.

www.licom.com Page 14
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Creating an Application Shortcut

An application shortcut is used to provide a quick and easy way of starting
applications. Shortcuts are usually created on the desktop. The simplest way to
create a shortcut is to drag and drop the applications icon using the right mouse
button.

This is how to create application shortcuts for Calculator, Notepad and Paint,
from the Accessories folder, which should still be displayed, onto the desktop.

[B" Position the cursor over the Calculator icon then, while holding down the

right mouse button, drag the icon to a new position on the desktop.
When the right button is released a popup menu is displayed pick the
“create a shortcut here” command. If you make a mistake and release the
right button with the icon in the wrong position, it is not a problem — you
simply select the Cancel command from the menu and try again.

" Try creating short cuts for Notepad and Paint.

[E" In addition to Calculator, Notepad and Paint shortcuts create a shortcut on

the desktop for the Solitaire application which can be found in the Games
folder.

[" Close all the open folders.

[B= Use the Solitaire application to become more familiar with selecting and
dragging and dropping. Also this application attempts to teach you to look
and read from all of the display.

If you are not sure how solitaire works select the Help Topics command
from the Help menu at the top of the solitaire screen.

www.licom.com Page 15
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Windows Explorer

The function of windows explorer is to enable you, to navigate through and
display the contents of the file structure. Explorer also allows you to create,
manipulate, and delete, files and folders.

Command Menu

Folders

:;_fj Desktop
- @. tdy Computer
¥ ;-J‘ 3% Floppy [&:]
—l-== Local Disk, [C:)
] AC&MOnlne
1 ADAPTEC
+ ] ADOEE&PP
] Alberti
1 Audio
] avi2mpg
] Books
"1 CADFILES

Jf

=[O0 x|
_ | ACAMOnline 3 FrontPage 'wet
_ 1 ADAPTEC 1 Graphicharks
] ADOBEAPP I HyperCam
| albert 1 LabFiles
1 dudio _Licam
1 avizmpa _ILICOMCFG
1 Bocks _ILICOMCFG. ald
1 CADFILES CILICOMDAT
LD ZILICOMDAT do
| Dacuments and Settings _ILICOMDIR
L1 Drive_T _ILICOMDIR.da
| D=F 3 mzpcint
| x o]

| »
1
Left Pane ]

Folder Tree Display. Only shows drives and folders

Right Pane J
Display of selected folders contents

The contents of your display will be different to the above picture. This is OK.

o] x|
= Back - [£] | Q) Search LY Folders ¢ Histary o | EH
Address |1 CALICOMDIRATUTORIAL | Pt

: l EZ Ei Y ¥ Ez -
= =
MestLetters 30 Simulation - 30 Simulation - S-awis - Cut B-amiz - Cut Alphacam
20 part.amnd  Multi Flane.a.. betweenco.. betweenco.. LogoEngra...
ba Wl
i o ___"
Alphacam logo  Alphacam  Auwto Dnill Lotz BRASS.bmp  Lathe chess  Lathe C-7° axiz
engraved.ard  Logo.amd of holes. ard piece. atd Example.atd
=Tl v 41 3 =g | ﬂ
32 object(s] 364 MB @ tdy Computer

The Explorer application window can be configured to display files and folders
in different ways. It is also possible to display a tool bar and status bar on the

explorer window.

www.licom.com
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To maintain control of the work you create, it will be necessary to develop a
directory structure in which to store your work.

From this page on there are some empty boxes.
Go through the rest of the book now and write

your name in each of the empty boxes. E.G

To start we will create a folder that is labelled with. |:|
[B" Left click [J on the [C:] icon in the Left pane. or Address bar

[E" Left click {J on the File Menu, or Right click [ with the cursor on [C:],
slide the pointer to the right (Cascade) from New and select the Folder
command.

A new folder will be created in the Right pane and its default name will be
New Folder. The New Folder name will be automatically highlighted, to

rename this folder type in |:| then press

If you make a mistake, you can rename a folder at any time. Right click {J on
the folder and select rename from the popup menu and the folder name will be

highlighted. Typing a new name will replace the old one. Press to close
the rename function.

[B" To open the folder |:|

Left Double click 2[J on it in the Right pane or
Left click {J on it in the Left pane..

To make sure that|:|directory is active you can look at either the

Left pane where the display will show an open =7 folder, or the title displayed
at the top of the Right pane. or in the Address Bar.

[B= Now create 2 new folders and give them names
Text Folder and Graphics Folder.
In the left pane the display should show a minus sign in front of the I~

|:| folder and the 2 sub folders will be displayed cascading below it.

If a plus sign is shown left click on it to display the sub folders. To open a
folder Left click {J on the folder name in the Left pane.

[B" Try moving between the folders you have created.
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You have created a folder structure, which would be symbolised by the
following diagrams.

|_E] C:
=0 ] |
| [(Graphics Folder |:|

| [(JText Folder | |

\Graphics Folder | [Text Folder |

Now that you have a filing structure we will create some text and graphics files.

Creating Text Files

To create text files you use a text editor or word processor. For this example we
will use AlphakEdit.

If you do not yet have AlphaEdit installed, Notepad can be used to create the
example text files.

Creating a text file is very simple. Firstly start up the application AlphakEdit.

Left Click {J on the AlphaEdit command by cascading through the menus as
shown. Start | Programs | AlphaCAM 2222| AlphaEdit + RS232 Comms

Or
Left Double Click 2{J on the Desktop or AlphaCAM folder Shortcut . @5

AlphaEDIT
+RSE32 .

When the AlphaEdit application starts you will see the following screen.

=10]x

= N
=3 File Edit View Format Utils Comms Window Help _|&| x|

D|E| & t|ele] o] &|=]q

STARTA ﬂ

o o

Feady Size B, Ln 2, Col1
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AlphaEdit always puts a START line as the first line. This is because it is
required for all AlphaCAM NC programs, which are to be downloaded onto the
machine tool using AlphaEdit’s communication commands.

The START line separates comments and notes from the NC program.

As this example is not an NC program, you can delete the START line by
pressing the Back Space key until is has been removed.

Editors allow mistakes to be corrected after you have finished typing ie edited.
Rules for using an editor.

The text will be entered into the file at the position of the Vertical Cursor |.

To reposition the vertical cursor either use the keyboard arrow keys or the
mouse with a left click {J to indicate the position required.

To insert text in a file, position the vertical cursor at the insert position, then
type in the text required.

To insert a new line in a file, position the vertical cursor at the insert position,
then press the enter or return key .

To highlight a word, position the | cursor on the word and left double 2(J click.

To highlight a section, position the | cursor at the start or end of the section,

hold down the left mouse button 2{J whilst moving the mouse to the end or
start of the section, then release the mouse button.

To highlight a line, position the cursor at the beginning of the line in the page
margin the cursor will change to ¢ . Left click {J to select the line..

A right click when the arrow cursor is over a highlighted section will display
the options menu.

Highlighted items can be: -
Replaced by typing in the replacement text.
Deleted by pressing the Del/Delete key.
Moved to a new location using Cut and Paste or Drag and Drop.
Copied to another location using Copy & Paste or Ctrl+ Drag and Drop.
Case Change through Capitalised Uppercase Lowercase using Ctrl + U

For global changes, ie. the same piece of text that needs to be changed in
several places throughout the file, use the Find and Replace options.
Searches will be restricted to a highlighted section.

Character case. This refers to the use of UPPER case characters (capital letters)
and lower case character (small letters). Some editors like AlphaEdit allow case
conversion, (swapping between upper and lower case characters) others like
NotePad do not. To type in mixed case characters AlphaEDIT needs to be
configured to allow lower case letters.

www.licom.com Page 19



LICOM Systems Introduction to Windows SAm

Below is a simple text file. Start up AlphaEdit or Notepad and type in this text.
Don’t worry if you make any mistakes as these can be corrected later. Do not
type the line END OF FILE, as this is to show you where to stop typing.

REMEMBER
AlphaEdit or NotePad does not automatically wrap the text round to the next
line to start a new line. Press [Enter<] the enter key at the end of each line.

Sample text file

You can use Notepad to create or edit text files that do not
require formatting and are smaller than 64K.

Notepad opens and saves text in ASCII (text-only) format only.
To create or edit files that require formatting or are larger than
64K, use WordPad.

WordPad is a text editor for short documents. You can format
documents in WordPad with various font and paragraph styles.

In Windows, you store your work in folders, just like you would
in your office or at home. You can look at your files and folders
by clicking My Computer. Inside My Computer, you can see a list
of all of the disk drives on your computer. Just double-click any
icon to see what'’s inside. When you open a disk drive, you can
see the files and folders that it contains.

Folders can contain files, programs, and other folders.

END OF FILE

www.licom.com Page 20



>»
S

LICOM Systems Introduction to Windows e

Saving Files to Disc

To save this file to disc, select the Save as NC/Text command from the File
menu and the Save As dialog will be displayed.

Save In Folder

Shows the active folder name Up One Level Icon Create New Folder lcon
= - O] x|
=i =18]x]
| 7| x
0| ==& . - | 2=
 You can @i [y LICOMDIR =] 5 - -
Hotepad | J3DTUTOR CIRTOOLS IVBMACROS a E|
To creat |_]autozave __ISCRATCH _WINMACRO thanl
514}{' ust | | Helpideos _1STO0LS
VordPad |- MTOOLS _1TTO0LS
document | Mestlists I TUTORIAL
In Winde | jpToOOLS 1 Tutorial Examples Ldq]
in wour der=1
by clicl =t
of all . anvi
icon to k||
see the Flenameg/ | Save
s _ s |
Folders  Save af ype: |Lic:|:|m MC Progran [*.ate) ﬂ Cancel -
! AN f
Feady Size 802, Ln 14, Co MM
Display Area Only folders and files with the
Shows the contents of the active folder default extension, will be shown

When saving files, it is MOST IMPORTANT to set the Save In directory to the
correct location, before saving the file. To change the Save In directory,
position the cursor into the save in field and left click. The Save In drop down
directory list will be displayed.

Save in | 'y LICOMDIR |
F;
' Name .:1} Dezktop

A Drop Down List ; 1= My Computer

Displays the Available Drives —‘ sT0 = 3
—ITTO = ]
ZaTut -
_‘I Tutor &5 Compact Dise (0]

[B" Select the [C:] drive. The contents of the selected drive will be shown in
the display area.

To move to the folder above the current Save In folder the Up One Level
button can be used.
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[ Select the 3 |:| folder in the display area and the Save button

will automatically change to an Open button. Pick the Open button and
the folder’s contents will be shown in the display area.

[B" Select the £ Text Folder folder in the display area and the Save button

will automatically change to an Open button. Pick the Open button and
the folder’s contents will be shown in the display area.

When the correct folder name, Text Folder, is displayed in the Save In field, the
File Name field needs to be activated. To activate the File Name field, position
the cursor in the File Name field and [J left click. The vertical text cursor will
then be displayed and the name of the file can typed in. For this example use
the file name “Sample Text File.txt”.

Don’t forget to use the quote marks otherwise the file will end up with the
name Sample Text File.anc. However it is not necessary to use the quote marks
and txt extension if NotePad is used as this is the file extension associated with
Notepad.

A file name extension is the part of the file name denoting the type of file. File
name extensions are historically 3 letters that follow a dot at the end of the file
name. It is the file extension that is associated with different applications
Some typical file name extensions are:

Axt  Text files (Notepad).

.doc  Word for windows and WordPad files.
.qic  Microsoft Backup files

.anc  AlphaCAM NC Program

.amd AlphaCAM Milling Drawing

A File extension identifies the type of data it contains and the system also
knows what software application uses such data.

If you use extensions to identify a particular type of file it is possible to register
it so that Windows knows which programs are used to Open Edit, Print the files
of this type.

Files of a registered type can be opened by a left double click on the file icon.

E.G. Files that are read back from the machine tool as proved programs could
be given the extension “.ncp”. This extension can be registered with windows
and AlphaEdit can be associated to Open these files.

To find out how to register file types select Start | Help and type reg then
select the option registering file types from the list of options.

When using Save As remember to look at where you are saving the file.
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Open an Existing file.
Simple

1 Start up the software application by left double clicking 2{J on the program
icon.

2  Select the Open command from the programs File menu or 7 button from
the toolbar.

3 From the Open dialog, if necessary, change the Look In to the folder that
contains the required file.

Lack in |l Test Folder ~] « & cf B-
'i)| Sample Text File tat

File rame: |Sam|:||e Text File.txt
Files of type: [0 Files (%] Rd Cancel

4 To see files with extensions that are different to the default extension, alter
the default file type from the File Types pull down display.

5 Select the required file name from the display area and then select the
Open button.

Note —

When you left Double Click 2{J on the filename in the open dialog it is the
same as selecting the file then selecting the Open button
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Advanced

Using Windows Explorer locate the required file.

[l x|
File Edit VYiew Favoritez Toolz Help n
<= Back - [£] | ‘QhSearch [ Folders &2 Histary Ko | e

Address ] C:ATest Folder =] @o
Folders -y g Sample Text File tat
] Screen Savers ﬂ
+l Share
+-] Temp
] Temp cd image
4 Teuxt Folder
<[] tmp
+-[_] TrainingCD
.71 bramekan hd
1] | 3
1 object(z] 217 bytes @ My Computer

Left double click 2{J on the file icon or Right click {7} on the file name and
select Open from the popup menu. This will start up the application associated
to the file type and display the files contents for editing.

If the file type has not been registered an “Open With” dialog will be displayed
allowing you to select the program that is to be used to open files of this type.

2]

Click the program wou want to use ko open
‘Sample Texk File,txt',
If the program is nok in the lisk, click Other,

Choose the program wou want o use:

Microsoft Excel For Windows ﬂ
"ff Microsoft Paint
@Microsoft Phota Editor
Microsoft PowerPoint For Windows
Microsoft Word For Windows J
A NCEDIT

gNotepad
P,

[ Always use this program to open these files

| Cancel | Cther... |

Some applications like AlphaCAM allow you to drag and drop a file from
Explorer, into the open application to load the file, or onto the application icon.

Once the file is open it can be changed, modified and manipulated as required.

Having modified the files contents the Save option is used to update the file in

its original position and the Save As option is used to save the file in a new
location and/or change its name.

When using Save As remember to look at where you are saving the file.
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Creating and Saving Graphics Files

The principle of creating and saving files, covered previously, applies
irrespective of its type. The differences in file type are to do with the software

application used to create them and the format in which they are stored on the
disk.

To create graphics files you use graphic applications such as AlphaCAM a
Vector Graphics application or Paint a Bitmap Graphics application.

For this example we will use Paint and create a bitmap picture file.

To create a graphics file we will use the Paint application. Start up the paint

B

application using the desktop shortcut Fsnt or the command from the
Start | Programs | Accessories menu.

The paint application screen will be displayed. This may only display as a small
screen but it can be made bigger by either stretching the window edges or

picking the [ button at the top right of the paint screen or Double click on the
title bar

=10] x|

File Edit Yiew Image Colorz Help

/;:: .

OD/?|‘%'&%‘¢A
O|F|~|F o=l

He
S

SRR A
4| | »

EECEEEECEENENE
[T H NERR NCENE

Faor Help, click Help Topics on the Help Menu.

Using the Brush tool in a round format draw your name on the display area. A
different colour can be used by selecting the colour required from the colour
pallet at the bottom of the screen.

Using the Spray tool and several colours create a pattern around your name or
any of the other tools to create a picture.
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=10] x|

File Edit Yiew Image | Help

.
)
¥

010/ él=%|% ]|

I_IEITIIIII_II_III_

For Help, click Help Topicz oh the Help Menu.

To save the file, select the Save As command from the File menu. Make sure

that the save in folder is Graphics Folder, which is under D|:|
folder on the C: Drive. Use the file name Name Picture.

Note:- This time there are no quote marks as the default .bmp file extension is
required to be automatically assigned to the file name.

This picture could be use as the background for your desktop display. To set
the desktop display use Help on the Start Menu and search the index for
“Desktop” items.
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Backup and Restore

Backup is a procedure to make a copy of your work in case anything goes
wrong with the computer system.

Why backup

Computer systems are electro-mechanical devices with moving parts, which
sometimes fail or wear out. They are also valuable and this makes them a target
for theft. Backing up is a way of storing all the work you create in an alternative
safe place.

Backup storage

Backups should be stored near to the computer for ease of access and also off
site for added security.

Backup media

There are many different backup devices ranging from standard 1.44Mb floppy
disks, high volume floppy disks 100-120Mb,writable CD 640Mb, Optical disk
600Mb, Standard Tape devices 400Mb 4Gb and Dat tapes 2Gb +.

Note-: 1Kb = 1 Kilobyte = approx. 1 thousand characters
™Mb = 1 Megabyte = approx. 1 million characters
1Gb = 1 Gigabyte = approx. 1000 million characters.

The backup device should be chosen with respect to

The amount of data likely to be backed up, (remember your system will grow).
The speed of the backup device,
Will there be somebody available during the backup process.

Backup Software

There are different backup programs. Some require operator intervention, others
are automatic. They all work in a similar manner, usually compressing and
comparing the data as it is saved and allowing the data to span more than one
disk or tape.

Backing up can be as simple as to copy the data to another disk (usually a
removable one) but it could be another hard disk on your network.

The backup software is Microsoft Backup as supplied with Windows 95. The
backup media will be a floppy disk.

If you use NT you can only backup to tape.

Backing up the work to date.

If you use Windows 95 try backing up you work to the floppy disk
If you use NT copy your folder to the floppy disk.
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Manipulating Data

Moving and copying file is required when data is saved in an incorrect location
or a duplicate file is required for amendment to create a new data file.

Windows Explorer is used to manipulate files and folders. There are several
ways in which files and folders can be moved or copied.

Selecting the files and folders

Usually the data to be manipulated is selected in the right pane of the explorer
display. Files and folders may be selected by different means.

1 To select an individual file or directory left click {J on the file icon.

2 To select a list of files which are displayed together, left click on {J the file
name at either the top or bottom of the list then left click {J whilst holding
down the Shift Key on the file name at the end of the list. All the
files between the two files picked will be selected.

3 To select several independent files left click on {J the first file name then
hold down the Ctrl Key whilst left clicking on [J the other files.

Manipulating Files and folders
Firstly select the files or folders to be moved or copied.

1 Whilst the cursor is on a selected item press the right mouse button and,
holding down the mouse button, drag {J& the selection so that the new
location for the data is highlighted. Release the button and a popup menu
will be displayed from which you can select the manipulation required.

2 Whilst the cursor is on a selected item right click {J and a popup menu will
be displayed from which you can select the manipulation required.
Right click on [} the new location for the data. The popup menu will be
displayed, and the Paste command can be selected.

Searching for Data files

The Find/Search command is located in either Start Menu on the taskbar or the
Tools menu in the Windows Explorer application.

When searching for files or folders special characters can be used so that it is
not necessary to enter the full name. The asterisk * is be used to represent any
number of unknown characters and the question mark ? is used to represent a
single character.

*.bmp would locate all files that end with .bmp on the search path.

*1* would locate all files with a number 1 any where in the filename
on the search path.

221* would locate all files with a number 1 as the third character in

the filename on the search path.
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Notes
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The Quiz
What is meant by logging on and off?

Name a program you use and describe your way of starting it?

What is a shortcut and how do you create them?

Design a simple folder diagram suitable for storing the Jobs data for the
following company:-

J.B. Eng. Sub Contract Engineers. They need to access information for both
Milling and Turning programs relating to specific Order Numbers for particular
Customers.
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What program is used to create a folder structure?

What program is used to manipulate data files?

Name an Editor and describe its function?

What is your Company’s Backup device?

How Often is your data backed up?

Who is responsible for backing up your data?

What AlphaCAM modules have your company purchased.
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